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Rhan I: Canllawiau Cyffredinol 
 

I.1 Trosolwg 

Bwriada Cyngor Llyfrau Cymru gynnig e-lyfrau i’r cyhoedd drwy ei wefan Gwales, ac 

annog gwerthwyr llyfrau sydd â gwefannau masnachol i wneud yr un modd. Er mwyn 

hyn mae wedi penodi Gardners fel ei gyflenwr e-lyfrau. Bydd Gardners yn derbyn 

ffeiliau ar fformat EPUB gan gyhoeddwyr fel y gallant gael eu cyhoeddi fel e-lyfrau 

gan ddefnyddio system Rheoli Hawliau Digidol (DRM) Adobe i sicrhau bod eu hawliau 

digidol wedi’u diogelu.   

Diben y ddogfen hon yw darparu cyfarwyddiadau a chanllawiau i gynorthwyo 

cyhoeddwyr Cymru i gynhyrchu ffeiliau ar fformat EPUB fel bod modd eu 

trosglwyddo i Gardners ar gyfer eu hamgryptio a’u dosbarthu. Bydd cynhyrchu 

llyfrau ar ffurf ffeiliau fformat EPUB hefyd yn hwyluso tasg y cyhoeddwyr o 

gynhyrchu e-lyfrau mewn fformatau e-lyfrau cyffredin eraill.  

Byddai’n fanteisiol petai gan y rhai sy’n ymwneud â’r gwaith trosi beth profiad o 

HTML a CSS. 

I.2 EPUB: safon a fformat 

Er mwyn i ffeil e-lyfr gael ei hystyried yn ffeil ar fformat EPUB rhaid iddi hi a’i 

chynnwys gydymffurfio â’r safon EPUB a ddatblygir gan yr International Digital 

Publishing Forum.  

Mae’r safon hon yn cael ei datblygu’n barhaus. Cyhoeddwyd fersiwn 3.0 o safon 

EPUB tra oedd y ddogfen hon yn cael ei hysgrifennu. Serch hynny, yn yr adroddiad 

hwn byddwn yn canolbwyntio ar fersiwn 2 o safon EPUB gan mai dyma’r fersiwn a 

ddefnyddir amlaf o hyd. 

Datblygir y safon EPUB drwy gonsensws aelodau’r IDPF. Mae aelodaeth yr IDPF yn 

cynnwys cyrff fel Apple, Adobe, Barnes & Noble, Google, Disney, Nokia. Mae’r 

aelodaeth yn agored; gellir ymuno â’r fforwm am ffi flynyddol drwy lenwi’r ffurflen 

gais ar y dudalen we hon: http://idpf.org/membership/application. Er nad oes angen 

ymuno er mwyn defnyddio’r safon EPUB, gellid gwneud hynny petai angen 

dylanwadu ar ddatblygiad y safon yn y dyfodol (er mwyn gweithredu nodweddion 

sydd o bwys i’r diwydiant cyhoeddi yng Nghymru, er enghraifft). 

Mae EPUB yn safon agored. Golyga hyn: 

 ei bod ar gael i bawb (http://idpf.org/epub) 

 nad oes angen talu ffi trwyddedu er mwyn ei defnyddio 

 nad yw’n eiddo cwmni neu gorff masnachol 

http://idpf.org/membership/application
http://idpf.org/epub
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 bod modd cyfrannu ati, os dymunir. 

 

Mae strwythur y cynnwys sydd o fewn ffeiliau EPUB yn seiliedig ar is-set gaeth o 

HTML, sef y dechnoleg a ddefnyddir yn gyffredin ar gyfer creu strwythur a chynnwys 

gwefannau. Drwy gyfyngu’r fformat i is-set sy’n galluogi’r nodweddion hynny sy’n 

angenrheidiol ar gyfer cyflwyno cynnwys llyfr, sicrhaodd EPUB 2.0 y gellid dangos e-

lyfrau EPUB ar ddyfeisiau e-ddarllen gweddol syml. Yn hynny o beth, nod safon EPUB 

yw pennu fformat agored safonol sy’n galluogi llifo ac ail-lifo testun, delweddau a 

thudalennau llyfr mewn modd priodol ar sawl math gwahanol o ddyfais neu 

feddalwedd e-ddarllen, waeth beth fo’u maint, natur eu rhyngwyneb, math o sgrin, 

eu gallu i ddangos lliw ayb. 

I.3 Rheoli hawliau digidol (DRM) 

DRM (Digital Rights Management) yw’r acronym ar gyfer meddalwedd neu ddarn o 

god sy’n galluogi’r sawl sy’n berchen ar yr hawliau deallusol ar gyfer cyfrwng digidol 

penodol (fel ffeiliau cerddoriaeth ac e-lyfrau, er enghraifft) i reoli eu dosbarthiad y tu 

hwnt i’r weithred o’u trosglwyddo i’r cwsmer y tro cyntaf. 

 

Er enghraifft, gellir gweithredu DRM drwy gyfyngu ar nifer y copïau y mae modd eu 

gwneud o’r cyfrwng, neu drwy gyfyngu ar nifer y dyfeisiau gwahanol y gellir dangos 

neu chwarae’r cyfrwng arnynt. 

 

Mae’r DRM a ddefnyddir gydag e-lyfrau yn tueddu i fod yn annibynnol ar fformat yr 

e-lyfr. Mae sawl dull DRM ar gael ar gyfer fformat EPUB, er enghraifft, ond nid oes 

rhaid defnyddio DRM o gwbl os na ddymunir gwneud hynny. 

Y DRM e-lyfrau y mae Cyngor Llyfrau Cymru yn ei ddarparu trwy gytundeb â 

Gardners yw Adobe DRM. Dyma’r DRM a ddefnyddir gan sawl cwmni blaenllaw.  

Ar hyn o bryd, o’r holl e-lyfrau sydd â DRM yn eu diogelu, EPUB ac Adobe DRM arno 

yw’r un sy’n cael ei gefnogi gan yr amrywiaeth mwyaf o ddyfeisiau a meddalwedd e-

ddarllen ar y farchnad.   

Mae rhestr o’r dyfeisiau a’r feddalwedd sydd â thrwydded i ddangos e-lyfrau EPUB â 

DRM Adobe ar gael yma: 

http://blogs.adobe.com/digitalpublishing/supported-devices 

Os nad yw cyhoeddwr yn ystyried rheoli hawliau digidol yn flaenoriaeth, gall y 

cyhoeddwr hwnnw gyhoeddi ffeiliau EPUB heb unrhyw fath o DRM. Byddai hyn yn 

golygu y byddai’r e-lyfr yn gweithio gyda dyfeisiau neu feddalwedd sy’n cefnogi EPUB 

ond nad ydynt yn gytûn ag Adobe DRM. Gellir hefyd ddefnyddio rhaglen Calibre i 

drosi ffeil EPUB i fformat MOBI. Byddai hyn yn caniatáu ei dosbarthu heb DRM ar 

gyfer dyfeisiau neu feddalwedd Kindle. Dylai unrhyw gyhoeddwyr sy’n bwriadu 

http://blogs.adobe.com/digitalpublishing/supported-devices
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gwneud hyn ystyried goblygiadau’r penderfyniad hwnnw yn ofalus; unwaith y 

dosberthir copïau heb DRM, ni fydd modd rhwystro trosi’r copïau hynny’n gopïau 

pellach yn y dyfodol. 

Amazon yw’r unig gwmni sy’n gallu dosbarthu e-lyfrau ar gyfer dyfais neu 

feddalwedd Kindle gyda DRM wedi ei alluogi arnynt. Mae modd i eraill greu e-lyfrau 

y gellir eu darllen gan ddefnyddio Kindle, a hynny yn annibynnol ar Amazon, ond ni 

fyddai modd gosod DRM ar y llyfrau hyn. 

I.4 Dosbarthwyr Gardners 

Mae angen i gyhoeddwyr sy’n awyddus i ddosbarthu e-lyfrau drwy wefan Gwales 

Cyngor Llyfrau Cymru drefnu gyda Gardners i drosglwyddo’u ffeiliau EPUB iddynt. 

Bydd Gardners yn rhoi cyfarwyddyd pellach i gyhoeddwyr sut i wneud hynny. 

I wneud y trefniadau trosglwyddo gyda chwmni Gardners mae angen cysylltu ag: 

Ali Balaban 

Gardners Books Ltd 

eBook Buyer 

1 Whittle Drive 

Eastbourne 

East Sussex 

BN23 6QH 

Gwaith: 01323 521555 Est 42052 

Symudol: 0788 7951280 

ali.balaban@gardners.com 
 

Bydd Gardners yn gosod DRM ar yr e-lyfr hwnnw ac yn galluogi iddo gael ei 

ddosbarthu trwy wefan Gwales, gwefannau siopau llyfrau, a llyfrgelloedd sydd â 

chyfrifon gydag Askews. 

Bydd y DRM a osodir ar yr e-lyfr yn gosod cyfyngiadau ar bob copi a brynir gan 

gwsmeriaid gwefan Gwales. 

Gweler adran FAQs Adobe Digital Editions am ragor o fanylion: 

http://www.adobe.com/products/digitaleditions/faq/ 

Mae perygl ynghlwm wrth gyflwyno llyfrau Cymraeg i Gardners ar ffurf 
PDFs neu ddelweddau, ar waethaf yr wybodaeth ganlynol ar eu gwefan:  
 

Digitise your hard copy using a proven process of scanning, OCR proofing and 
tagging. This process has an accuracy level of less than 20 defects in a million 
characters which amounts to 99.998% accurate content. 
 

http://www.gardners.com/gardners/content/Publishers/Digital_Warehouse/Digital_

Corp_Brochure.pdf 

mailto:ali.balaban@gardners.com
http://www.adobe.com/products/digitaleditions/faq/
http://www.gardners.com/gardners/content/Publishers/Digital_Warehouse/Digital_Corp_Brochure.pdf
http://www.gardners.com/gardners/content/Publishers/Digital_Warehouse/Digital_Corp_Brochure.pdf
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Nid yw’r broses hon yn addas ar gyfer y Gymraeg oherwydd bod y feddalwedd sganio 

OCR a ddefnyddir yn seiliedig ar gyfuniadau llythrennau’r iaith Saesneg. 

1. Gall y testun o fewn dogfen PDF fod wedi’i gadw ar ffurf delwedd o’r testun 

yn hytrach na chyfres o nodau (llythrennau ac ati) digidol. 

2. Mae dogfennau PDF yn tueddu i gadw testun dogfen fesul llinell, gan osod 

stop caled ar ddiwedd pob llinell. Mae hyn yn rhwystro’r testun rhag llifo, o’i 

drosi i fformat arall. 

Er bod Gardners yn gywir i honni bod y canlyniadau a geir o ddefnyddio meddalwedd 

OCR yn dda iawn ar gyfer y Saesneg, nid yw’n berffaith. Er enghraifft, yn fersiwn e-

lyfr Amazon o A Clash of Kings: Book Two of A Song of Ice and Fire gan George R. R. 

Martin, mae enghraifft o’r gair ‘litter’ wedi ei drosi ar gam yn ‘Utter’: 

“and a mother cat with a Utter of new-born kittens.” 

Location 3750 – 3754 

Mae’r gwall hwn yn nodweddiadol o wall sganio. I’r cyfrifiadur, mae ‘li’ yn edrych yn 

debyg i ‘U’. Ni fyddai golygydd dynol wedi ychwanegu’r gwall hwn. 

Am y rhesymau a restrir uchod, argymhellir na ddylid ceisio trosglwyddo PDF o lyfr 

Cymraeg i Gardners i’w drosi’n e-lyfr drwy ddefnyddio OCR.  

I.5 Creu ffeiliau EPUB 

Er y gellid creu EPUB â llaw gan ddefnyddio rhaglen golygu testun syml fel Notepad 

[jedisaber.com epub], yn y rhan fwyaf o sefyllfaoedd mae’n gynt ac yn haws 

defnyddio meddalwedd sydd wedi’i chreu neu ei haddasu’n bwrpasol ar gyfer 

cynhyrchu e-lyfrau yn y fformat hwnnw. 

Er mwyn trosi llyfr sydd eisoes wedi’i osod ar gyfer print i ffurf e-lyfr, mae gan 

feddalwedd cyhoeddi bwrdd gwaith traddodiadol fel Quark ac InDesign bellach y 

gallu i gynhyrchu fersiynau e-lyfr o ddogfennau a grëir ynddynt.  

Lle nad oes fersiwn wedi’i osod ar gyfer print yn bodoli, gellir dewis creu e-lyfr yn 

Quark neu InDesign neu ddefnyddio Sigil, meddalwedd rydd ac am ddim sy’n 

canolbwyntio’n unig ar greu e-lyfrau. Mae rhyngwyneb Sigil yn llawer symlach na 

rhyngwyneb Quark ac InDesign, ac mae’n canolbwyntio’n unig ar y nodweddion 

hynny sy’n drosglwyddadwy i e-lyfr. O ganlyniad, mae’n ddefnyddiol iawn ar gyfer 

creu e-lyfrau lle na fwriedir cyhoeddi fersiwn print ohonynt. Mae Sigil hefyd yn 

cynnwys sawl nodwedd sy’n ei wneud yn arf defnyddiol ar gyfer tacluso a mireinio e-

lyfrau a gynhyrchir gan InDesign a QuarkXpress.  

Ni thrafodir QuarkXpress yn fanwl yn y canllawiau hyn, ond  ewch i 

http://www.youtube.com/watch?v=7t6g4kdXL3Y i weld tiwtorial fideo sy’n dangos 

sut i gynhyrchu e-lyfr gan ddefnyddio QuarkXpress 9. 

http://jedisaber.com/
http://www.youtube.com/watch?v=7t6g4kdXL3Y
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Dewis arall fyddai creu’r llyfr mewn rhaglen arall fel Microsoft Word, a chadw copi 

o’r llyfr hwnnw ar ffurf HTML. 

File > Save As > Save as type: > Web, Filtered 

Gellir agor y ddogfen HTML honno o fewn rhaglen golygu testun fel Notepad++ (sydd 

ar gael o’r we am ddim) a chopïo’r cod draw i Code View Sigil (View > Code View), a 

golygu’r testun yn SIGIL o hynny allan. 

Yn wahanol i Quark ac InDesign, nid yw’n ceisio darparu ar gyfer cyhoeddi print. 

Mae Sigil hefyd yn ddefnyddiol ar gyfer golygu e-lyfrau a gynhyrchwyd gan raglenni 

eraill e.e. InDesign oherwydd ei fod yn caniatáu i chi edrych oddi mewn i’r ffeil EPUB 

er mwyn golygu cod y ffeil yn uniongyrchol a gweld y newidiadau hynny ar waith. 

Mae gwybodaeth fanwl ar y broses o drosglwyddo testun i Sigil i greu e-lyfr EPUB ar 

gael o’r gwefannau hyn: 

http://www.paulsalvette.com/2011/08/turning-manuscript-into-clean-

xhtml.html#c6 

http://www.jedisaber.com/eBooks/ 

I.6 Adobe InDesign 

InDesign yw’r rhaglen cyhoeddi bwrdd gwaith a ddefnyddir yn fewnol gan Gyngor 

Llyfrau Cymru.  

InDesign yw’r rhaglen cyhoeddi bwrdd gwaith fwyaf poblogaidd ar y farchnad ar hyn 

o bryd, a fersiwn CS 5.5 yw’r fersiwn cyfredol ohoni. Awgrymir y dylai unrhyw 

gyhoeddwr sydd am ddefnyddio InDesign i gynhyrchu e-lyfrau ddiweddaru i’r fersiwn 

cyfredol gan ei fod yn cynnwys nifer o welliannau i’r ddarpariaeth e-gyhoeddi. 

Mae gan InDesign CS 5.5 y gallu i gynhyrchu ffeil EPUB o ddogfen InDesign. Mae’r 

nodwedd hon ar gael drwy glicio ar File > Export  ac yna dewis EPUB o’r gwymplen 

Save as type: (noder bod y drefn hon yn wahanol i drefn InDesign CS 5, sef clicio ar 

File > Export for > EPUB ). Fodd bynnag, cyn defnyddio InDesign i gynhyrchu dogfen 

ar ffurf EPUB, dylid paratoi’r cynnwys er mwyn i’r ffeil gynhyrchu’n lân. 

Wrth osod dogfen gan ddefnyddio meddalwedd cyhoeddi bwrdd gwaith, gellir pennu 

arddulliau penodol i’w defnyddio gyda pharagraffau, penawdau ac elfennau fel teip 

trwm ac italig, a thanlinellu. Mae’n bwysig defnyddio’r arddulliau hyn wrth greu 

dogfen a fydd yn cael ei throsi’n e-lyfr.  

Mae InDesign yn rhannu’r arddulliau hyn yn ddau fath, sef arddulliau nodau 

(character styles) ac arddulliau paragraff. Defnyddir arddulliau nodau ar gymalau, 

geiriau a llythrennau unigol o fewn paragraffau er mwyn eu gosod mewn teip trwm, 

italig neu danlinellu, heb newid arddull y paragraff cyfan.  

http://www.jedisaber.com/eBooks/
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Defnyddir arddulliau paragraff ar gyfer rheoli arddull paragraffau cyfan, er enghraifft 

er mwyn gosod maint uchder llinellau’r paragraff neu fewnoli’r llinell gyntaf. 

Wrth gynhyrchu e-lyfr o’r ddogfen, mae’n hanfodol fod defnydd trwyadl a chyson 

wedi’i wneud o arddulliau paragraffau ac arddulliau nodau yn y ddogfen sydd i’w 

chyhoeddi. Bydd gwneud hynny’n gymorth mawr i sicrhau y caiff yr e-lyfr ei 

gynhyrchu’n gywir. 

Ceir canllawiau manwl ynghylch sut i ddefnyddio InDesign i greu ffeiliau EPUB yn 

rhan II y ddogfen hon. 

I.7 Agor a throsi ffeiliau EPUB 
 
Gallwch weld cynnwys ffeil EPUB drwy ei hagor gyda Sigil (gw. I.5 uchod), neu ddilyn 

y cyfarwyddiadau isod ar gyfer gwneud hynny â llaw drwy drosi’r ffeil yn ffolder ZIP. 

Trosi ffeil EPUB yn ffeil ZIP 

Yn ei hanfod, ffeil ZIP yw ffeil EPUB, â therfyniad .epub yn hytrach na’r terfyniad .zip 

arferol. Gellir profi hyn drwy newid estyniad ffeil EPUB o .epub i .zip.  

Mae’n bosib y bydd angen i chi newid gosodiadau eich system weithredu i ddangos 

estyniadau ffeil er mwyn gallu gwneud hyn: 

Ar gyfer Windows Vista, Windows 7, a Windows Server 2008 

 Agorwch Windows Explorer. 

 Cliciwch ar Organize. 

 Cliciwch ar Folder a search options. 

 Cliciwch ar y tab View. 

 Sgroliwch i lawr at Hide extensions for known file types, a dad-dicio’r blwch 
ticio.  

 Cliciwch ar OK. 

Ar gyfer Windows 2000, Windows XP, and Windows Server 2003 

 Agorwch Windows Explorer. 

 Cliciwch ar Tools ac yna ar Folder Options. 

 Sgroliwch i lawr a chlicio ar Folder a search options. 

 Cliciwch ar y tab View. 

 Sgroliwch i lawr at Hide extensions for known file types, a dad-dicio’r blwch 
ticio.  

 Cliciwch ar OK. 
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Ar gyfer Mac OS X, cliciwch ar: 

Finder > Preferences > Advanced >  Show all file extensions 

Er enghraifft, o newid enw ffeil o’r enw enghraifft.epub i enghraifft.zip byddai modd 

ei ddatgywasgu a’i agor fel petai’n ffeil ZIP gyffredin. Mae’r ffeil .epub felly yn 

gweithredu fel cynhwysydd ar gyfer nifer o isffolderi a ffeiliau unigol sydd â 

swyddogaethau gwahanol. 

I.8 Cynnwys ffeiliau EPUB 

Ar ôl newid estyniad ffeil .epub gyffredin i .zip, ei datgywasgu a’i hagor, yr hyn a 

gewch o’i mewn yw dwy ffolder, sef OEPBS (Open eBook Publication Structure) a 

META-INF, yn ogystal ag un ffeil fach ond pwysig o’r enw mimetype. 

OEPBS 
Oddi mewn i’r ffolder OEPBS cedwir prif gynnwys yr e-lyfr. Mae’r cynnwys hwnnw 

wedi’i rannu’n nifer o ffolderi a ffeiliau – rhai ohonynt yn ofynnol a rhai ohonynt yn 

ddewisol.  

Cynnwys y ffolder OEPBS hon a ddangosir yn ffenestr chwith Sigil. 

Ffolder ‘Fonts’ ar gyfer ffontiau (ffolder ddewisol) 

Gellir gosod ffontiau penodol o fewn ffeil EPUB fel eu bod ar gael i’w defnyddio o 

fewn yr e-lyfr. Nid yw pob dyfais na rhaglen e-ddarllen yn caniatáu i e-lyfr bennu’r 

ffont a ddefnyddir wrth ddangos cynnwys e-lyfr. Os caiff ffontiau eu mewnblannu yn 

yr e-lyfr, yr arfer yw cadw ffeiliau’r ffontiau hynny mewn ffolder ‘Fonts’ o fewn y 

ffolder OEBPS. 

Cynnwys yr e-lyfr ar ffurf ffeiliau HTML 

O fewn y ffolder OEBPS ceir ffeiliau .html rhydd, er enghraifft pennod1.html, 
pennod2.html. Y rhain yw’r ffeiliau sy’n cynnwys tudalennau a thestun yr e-lyfr. Fel 
arfer, mae’r ffeiliau XHTML unigol hyn yn cyfateb i benodau neu adrannau unigol y 
llyfr. Mae rhannu cynnwys y llyfr fel hyn yn lleihau’r baich ar gof y ddyfais e-ddarllen, 
ond gellir rhannu cynnwys llyfr yn fwy mympwyol na hyn heb i’r rhaniadau fod yn 
amlwg i’r darllenydd. Yn ôl safon EPUB, dylai’r ffeiliau unigol hyn fod yn llai na 300kb 
yr un, gan y gall defnyddio ffeiliau mwy arafu’r ddyfais neu’r feddalwedd e-ddarllen. 

 

Tabl cynnwys - toc.ncx 
Saif ‘toc’ am ‘table of contents’, a dyma’r enw a roir yn gyffredin ar y ffeil .ncx a geir 
yn y ffolder OEBPS. Mae gan y mwyafrif o ddyfeisiau a rhaglenni meddalwedd e-
ddarllen y gallu i ddangos panel llywio gyda thabl cynnwys yr e-lyfr ar ffurf dolenni 
sy’n caniatáu i ddefnyddwyr neidio’n syth i adrannau neu benodau penodol. Mae’r 
ffeil toc.ncx yn pennu strwythur y panel llywio hwn. 
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Ffolder ‘Images’ ar gyfer delweddau 

Y ffolder ‘images’ o fewn y ffolder OEBPS yw’r lleoliad lle caiff unrhyw ddelweddau a 

geir o fewn yr e-lyfr eu cadw. Gellir cadw’r delweddau ar ffurf gif, jpg neu png. 

Folder ‘Styles’ – arddulliau CSS 

Rheolir arddulliau gweledol yr e-lyfr gan ffeil neu ffeiliau .css. Caiff y rhain eu cadw 

fel rheol o fewn ffolder o’r enw Styles o fewn y ffolder OEBPS. Wrth greu e-lyfr gan 

ddefnyddio InDesign, bydd InDesign yn trosi’r arddulliau paragraff a’r arddulliau nod 

yn arddulliau CSS. Fel arfer, cânt eu storio gyda’r arddulliau angenrheidiol eraill 

mewn ffeil o’r enw templates.css. 

Saif CSS am ‘cascading style sheet’. Mae ffeil CSS yn cynnwys arddulliau ar gyfer 

gwahanol elfennau’r e-lyfr. Cyfeiria’r elfen ‘cascading’ at y ffaith fod arddull 

uwchelfen yn goferu i’w his-elfennau. Dyma a ddefnyddir hefyd i reoli gosodiad 

gwefannau. 

 

Mae ffeil EPUB ddefnyddiol ar gael o’r wefan ganlynol er mwyn profi sut y mae 

gwahanol arddulliau’n ymddangos mewn gwahanol e-ddarllenwyr: 

http://rufus.deuchler.net/2010/10/css-and-xhtml-tags-for-epub.html 

 

Mae ymdriniaeth lawn o CSS y tu hwnt i gylch gorchwyl y canllawiau hyn, ond mae 

nifer o adnoddau defnyddiol a chynhwysfawr i’w cael ar y we yn rhad ac am ddim, 

e.e. W3schools: 

 

http://www.w3schools.com/css/default.asp 

Gair o rybudd – er ei ymrwymiad i safon CSS, nid yw pob e-ddarllenydd wastad yn 

dehongli CSS yn yr un modd. 

content.opf 

Hon yw’r ffeil sy’n cynnwys manylion yr e-lyfr. Mae’r manylion hyn yn cynnwys y 

canlynol: 

Metadata 

e.e. 

 teitl yr e-lyfr 

 manylion ffeil clawr y llyfr 

 awdur(on) yr e-lyfr 

 allweddeiriau pwnc yr e-lyfr 

 disgrifiad o’r llyfr 

 manylion y cyhoeddwr 

http://rufus.deuchler.net/2010/10/css-and-xhtml-tags-for-epub.html
http://www.w3schools.com/css/default.asp
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 dyddiad cyhoeddi 

 hawlfreintiau 

 manylion iaith 

 rhif adnabod unigryw (e.e. ISBN) 

etc. 

Maniffest 

Rhestr o bob ffeil adnodd a ddefnyddir yn yr e-lyfr, y math o ffeil, a’i lleoliad o 

fewn y cynhwysydd EPUB. 

Enghraifft o gofnod maniffest ar gyfer clawr e-lyfr: 

<item id="clawr.gif" href="images/clawr.gif" media-type="image/gif"/> 

Spine 

Rhestr o’r dogfennau XHTML sy’n cynnwys testun y llyfr. Mae’r ffeiliau 

XHTML unigol fel arfer yn cyfateb i benodau neu adrannau unigol yr e-lyfr. 

Cânt eu rhestru yn eu trefn ddarllen. 

META-INF 
Y prif ffeil a geir yn y ffolder hon yw’r ffeil container.xml. Pwrpas y ffeil honno yw 

cyfeirio’r e-ddarllenydd at y ffeil (sef content.opf yn y ffolder OEPBS fel arfer) sy’n 

cynnwys holl fanylion yr e-lyfr, gan gynnwys metadata fel enw’r awdur a’r 

cyhoeddwr, yn ogystal â rhestr o’r holl ffeiliau a ddefnyddir gan yr e-lyfr.  

Gall y ffolder hefyd gynnwys ffeiliau eraill (fel encryption.xml os yw’r e-lyfr yn 

cynnwys ffontiau sydd wedi’u hamgryptio), ond container.xml yw’r unig ffeil ofynnol. 

mimetype 
Y ffeil fach ddi-nod hon yw’r ffeil sy’n dweud wrth y system pa fath o ffeil ydi hi. Un 

o’r gwallau cyffredin wrth greu ffeil EPUB â llaw (yn hytrach na mewn rhaglen fel 

InDesign) yw cywasgu’r ffeil hon wrth gywasgu’r ffolder EPUB. Wrth greu ffeil EPUB â 

llaw, dylid ychwanegu’r ffeil hon i’r ZIP heb ei chywasgu. 

Am ragor o wybodaeth, gweler: 

http://wiki.mobileread.com/wiki/EPub 
 

I.9 Trosi EPUB i fformatau eraill 

Mae creu e-lyfr ar fformat EPUB hefyd yn fan cychwyn da ar gyfer ei drosi i un o’r prif 

fformatau eraill ar gyfer e-lyfrau. 

 

Er enghraifft, gellir defnyddio’r rhaglen cod agored Calibre i drosi llyfr fformat EPUB 

http://wiki.mobileread.com/wiki/EPub
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yn ffeil fformat AZW neu MOBI. Yr un yw’r ddau fformat mewn gwirionedd, gan fod 

fformat AZW cwmni Amazon wedi’i seilio ar fformat e-lyfrau Mobipocket (.mobi neu 

.prc) a ddatblygwyd gan gwmni o’r un enw a brynwyd gan Amazon yn 2005. Y prif 

wahaniaeth rhwng ffeiliau AZW a ffeiliau Mobipocket (sydd ag estyniad .pcr neu 

.mobi) yw y gall ffeiliau AZW gynnwys DRM Amazon.  

 

Gall Amazon dderbyn e-lyfrau ar ffurf EPUB gan gyhoeddwyr a’u trosi ar eu cyfer i 

fformat AZW.  

 

Ar hyn o bryd, nid yw Amazon wedi galluogi eu dyfeisiau a’u meddalwedd e-ddarllen 

hwy i weithio gyda fformat EPUB na DRM gan ddarparwyr allanol. Yr unig ffordd y 

gall cyhoeddwr gyhoeddi e-lyfr sydd wedi’i ddiogelu â DRM ar gyfer Kindle yw trwy ei 

gyflwyno i Amazon a’i werthu ar wefan Amazon. 

 

Maent bellach yn derbyn llyfrau Cymraeg a gellir cysylltu’n uniongyrchol â hwy am 

gymorth ychwanegol os oes angen.  

I.10 Amgodio Nodau 
Wrth symud testun o un ddogfen i’r llall, rhaid bod yn ofalus na chaiff yr amgodio a 
ddefnyddir ar gyfer y nodau (y llythrennau, rhifau ac ati) ei newid yn ddamweiniol, 
gan y gall hyn arwain at golli’r acenion oddi ar yr ŵ a’r ŷ, neu i’r llythrennau hynny 
gael eu cynrychioli â ?.  

Mae sawl set nodau (character set) gwahanol yn bodoli, er enghraifft ASCII sy’n 

cynnwys llythrennau di-acen yn unig, ac ISO-8859-1 sy’n cynnwys y llythrennau 

acennog a geir yn ieithoedd mwyaf cyffredin Ewrop, ond sydd heb ddarpariaeth ar 

gyfer ŵ ac ŷ.  

Pan fyddwch yn copïo testun sy’n cynnwys ŵ ac ŷ i raglenni golygu testun fel 

Notepad++ sicrhewch fod yr amgodio mae’r rhaglen yn ei ddefnyddio ar gyfer y 

ddogfen wedi’i osod i UTF-8 neu fe all yr acenion gael eu colli.  

Gweler http://www.fileformat.info/info/unicode/ am restr chwiliadwy o’r glyffiau a 

geir yn UTF-8, neu http://unicode.org/charts/PDF/U0100.pdf am ddogfen PDF sy’n 

eu rhestru. 

 
Mewnbynnu nodau arbennig i god 

Gellir defnyddio gwahanol godau er mwyn cynrychioli’r nodau arbennig hyn mewn 

cod:  

Er enghraifft, mae’r enw endid &wcirc; a’r rhif endid  &#x175; ill dau yn cynrychioli’r 

llythyren ‘ŵ’. Mae’r enw endid yn fwy ymarferol o ran defnyddwyr. 

http://www.fileformat.info/info/unicode/
http://unicode.org/charts/PDF/U0100.pdf
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Ŵ &Wcirc; U+00174 &#x174; &#372; 

 

ŵ &wcirc; U+00175 &#x175; &#373; 

 

Ŷ &Ycirc;  U+00176 &#x176; &#374; 

 

ŷ &ycirc;  U+00177 &#x177; &#375; 
 

Mae’r arbenigwr Paul Salvette yn awgrymu trosi nodau yn enwau endid HTML mewn 

cod. Ond, nid oedd safon HTML 4 yn cynnwys enwau endid HTML ar gyfer ‘ŵ’, ‘Ŵ’, 

‘ŷ’ ac ‘Ŷ’ ac o ganlyniad nid yw enwau endidau fel &wcirc; ac &ycirc; yn gweithio gyda 

ffeiliau e-lyfrau, er bod &acirc; er enghraifft yn gwneud hynny. 

Pwysigrwydd ffontiau 

Cofiwch hefyd na fydd ŵ ac ŷ yn ymddangos yn gywir er i chi ddewis yr amgodio 

cywir os na fydd gan y ffont a ddefnyddir glyffiau (delwedd sy’n cynrychioli llythyren)  

ar gyfer ŵ ac ŷ. 

Nodau argraffwyr 

Gellir hefyd ddefnyddio’r adnoddau Unicode uchod i ddarganfod y codau cywir ar 

gyfer nodau atalnodi e.e.: 

 elipsis  

 llinellau toriad ( ‒, –, —,) 

 dyfnodau 66 a 99 (  ‘ ’, “ ” ) 

Gweler hefyd: 

http://en.wikipedia.org/wiki/Dash 

 

http://en.wikipedia.org/wiki/Dash


14 

Rhan II: Cyfarwyddiadau sut i greu e-lyfr EPUB yn InDesign 
 

II.1 Creu dogfen 
I’r defnyddiwr newydd, y cam cyntaf yw creu dogfen brawf i arbrofi â hi. I lunio 

dogfen newydd yn InDesign mae angen clicio ar:  

 

File > New > Document 

Byddwn yn creu dogfen a fydd yn gweithio fel sail ar gyfer llyfr print ac e-lyfr, felly 

bydd angen nodi eich bwriad fel Print: 

 

Intent: Print 

Os ydych yn dymuno gweld cynnwys y llyfr fel dwy dudalen agored, ticiwch y blwch 

ger Facing Pages. 

☑ Facing Pages 

Ar gyfer y ddogfen brawf, fe bennwn ni’r Number of Pages: yn 1 (bydd modd 

ychwanegu rhagor o dudalennau wrth weithio). 

 

Mae’r dewisiadau o ran maint y dudalen, nifer y colofnau ac ymyl a chyfeiriadaeth y 

dudalen yn amherthnasol i’r e-lyfr, felly defnyddiwch yr hyn sy’n briodol ar gyfer 

gosodiad llyfr print. Os cyhoeddi ar ffurf e-lyfr yn unig yw’r bwriad, gallwch ddewis 

maint dogfen sy’n ffitio’n dwt ar y eich sgrin, neu sy’n cyfateb i’r brif ddyfais e-

ddarllen rydych yn ei thargedu. 

II.2 Creu maes testun 

Y cam nesaf yw ychwanegu maes testun i’r dudalen. I ddewis yr arf testun (sy’n eich 

galluogi i greu maes testun), cliciwch ar y botwm â’r llun T sydd yn y bar offer ar y 

chwith yn InDesign. 

Caiff yr ardal sydd o fewn ymylon y dudalen ei dangos ag amlinell binc yn InDesign. 

Mae’n syniad gosod y maes testun o fewn yr ymylon diffiniedig hyn, felly cliciwch a 

llusgo o gornel chwith uchaf yr amlinell pinc i’r gornel isaf ar y dde. Os oes angen, 

gellir tacluso’r maes testun ymhellach trwy glicio ar ei gorneli a’u llusgo i’r man 

cywir. 

II.3 Ychwanegu tudalennau  

Yn ffenestr y ddewislen Pages sydd ar ochr dde y sgrin (cliciwch ar Windows > Pages 

os nad yw yn y golwg), de-gliciwch ar yr eicon tudalen ac yna dewis Duplicate Page 

o’r ddewislen er mwyn creu copi o’r dudalen. Os nad yw Duplicate Pages ar gael eto, 

dewiswch Duplicate Spread. 
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Unwaith y bydd tudalen ychwanegol wedi’i chreu, mae angen gosod y meysydd 

testun sydd arnynt fel eu bod yn llifo o un dudalen i’r nesaf. Gwneir hyn drwy glicio 

ar y maes testun ar y dudalen gyntaf er mwyn ei dewis ac yna glicio ar y blwch sgwâr 

bach glas sydd ar ffrâm y maes testun, fymryn yn uwch na’i chornel dde waelod. 

Bydd hyn yn peri i’r pwyntydd newid yn eicon. Dylid yn awr glicio ar faes testun y 

dudalen nesaf. Bydd hyn yn peri bod y testun yn llifo o’r dudalen gyntaf i’r dudalen 

nesaf pan fydd y tudalen gyntaf yn llenwi â thestun. 

Gallwch glicio ar View > Extras > Show Text Threads er mwyn dangos llinellau sy’n 

dangos pa feysydd testun sydd wedi’u cysylltu â’i gilydd (rhaid i chi fod wedi clicio ar 

faes testun iddo fod yn y golwg).   

Crëwch 6 tudalen fel y disgrifiwyd uchod yn eich dogfen, gan gofio ychwanegu 

meysydd testun atynt, a chysylltu un maes testun at y nesaf. 

II. 4 Ychwanegu testun y teitl a’r hawlfraint 

Y cam nesaf yw ychwanegu testun i’r ddogfen. Ychwanegwch y testun canlynol i 

dudalen 3 y ddogfen, sef y dudalen deitl a’r hawlfraint: 

Teitl 

gan Enw’r Awdur 

Hawlfraint © 2011 Deiliad yr Hawlfraint 
 

(Gallwch gyfnewid y teitl, enw’r awdur, y flwyddyn, a manylion deiliad yr hawlfraint 

am destun priodol, os ydych yn dymuno). 

II.5 Gosod yr arddull sylfaenol ar gyfer testun yr e-lyfr 

Pan gaiff dogfen newydd ei chreu, bydd y ddogfen honno eisoes yn cynnwys arddull 

paragraff sylfaenol o’r enw [Basic Paragraph]. Byddwn yn defnyddio’r arddull hon fel 

sylfaen ar gyfer arddulliau eraill. Gallwn bennu maint testun a ffont ar gyfer yr 

arddull hon, a bydd yr holl arddulliau a grëwn yn etifeddu’r maint ffont a’r ffont 

hwnnw. 

Rhaid i’r ffont hwnnw gynnwys glyffiau ar gyfer ŵ ac ŷ os ydych am i’r llythrennau 

hynny ymddangos yn gywir yn yr e-lyfr. 

Nid yw ffont arferol Adobe Digital Editions yn cynnwys glyffiau ar gyfer ŵ ac ŷ. Os 

ydych am i’r llythrennau hynny ymddangos yn gywir yn Adobe Digital Editions, mae’n 

rhaid: 

 dewis ffont sydd â glyff ar gyfer ŵ ac ŷ 

 ei ddefnyddio fel y ffont ar gyfer testun eich e-lyfr 

 gosod copi o’r ffont hwnnw ŵ ac ŷ yn yr e-lyfr 
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 Os ydych yn mynd i fewnblannu ffontiau yn yr e-lyfr, bydd angen defnyddio ffontiau 

y mae gennych drwydded i’w ddosbarthu. Mae ffontiau rhad ac am ddim sy’n rhydd 

at y dibenion hyn i’w cael yma: 

http://scripts.sil.org/cms/scripts/page.php?item_id=CharisSIL_download 

http://en.wikipedia.org/wiki/Liberation_fonts 

https://fedorahosted.org/liberation-fonts/ 

http://en.wikipedia.org/wiki/DejaVu_fonts 

http://dejavu-fonts.org/wiki/index.php?title=Download 

Os nad ydych chi’n gyfarwydd â ffeiliau tar.gz, mae’n bosib y bydd angen i chi osod 

rhaglen echdynnu fel ZipGenius i agor rhai o’r ffeiliau hyn: http://www.zipgenius.it/ 

II.6 Gosod arddull ar gyfer y teitl a’r hawlfraint 

Y cam nesaf yw creu arddull benodol ar gyfer y teitl er mwyn cynyddu maint y ffont a 

ddefnyddir ar ei gyfer, ei ganoli, a newid pwysau’r ffont yn deip trwm. I wneud hyn 

rhaid defnyddio’r ffenestr Paragraph Styles. Os nad yw yn y golwg gennych yn 

newislen dde InDesign, cliciwch yma i’w hagor: 

Window > Styles > Paragraph Styles 

Ar waelod y ffenestr Paragraph Styles mae eicon sy’n debyg i ddalen sgwâr a chornel 

waelod y dudalen wedi’i throi. Dyma’r eicon Create new style. Cliciwch arno i greu 

arddull newydd o’r enw Paragraph Style 1, a fydd yn ymddangos yn y rhestr o 

arddulliau a ddangosir yn y ffenestr. 

 Dwbl-gliciwch ar enw’r arddull.  

 Teipiwch ‘Teitl’ yn y blwch Style Name: dros y teitl presennol. 

 Cliciwch ar Basic Character Formats yn y ddewislen ar y chwith.  

 Newidiwch Font Style: i Bold. 

 Newidiwch Size: i 24pt. 

Gallwch ddewis ffont bryd hyn hefyd, ond does dim llawer o ddiben gwneud hynny 

ar gyfer e-lyfrau gan fod y mwyafrif o ddyfeisiau yn anwybyddu eich dewisiadau. 

Er mwyn canoli’r testun Teitl: 

 Cliciwch ar Indents and Spacing yn y ddewislen ar y chwith ac yna dewiswch Centre 
o’r ddewislen Alignment. 

 Cliciwch ar OK. 

http://scripts.sil.org/cms/scripts/page.php?item_id=CharisSIL_download
http://en.wikipedia.org/wiki/Liberation_fonts
https://fedorahosted.org/liberation-fonts/
http://en.wikipedia.org/wiki/DejaVu_fonts
http://dejavu-fonts.org/wiki/index.php?title=Download
http://www.zipgenius.it/
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Dylech yn awr fod wedi creu arddull paragraff o’r enw Teitl. Y cam nesaf yw gosod yr 

arddull honno ar y teitl. 

I wneud hynny, dewiswch destun y teitl fel bod y cyfan ohono wedi’i amlygu, ac yna 

cliciwch ar yr arddull teitl yn y ffenestr Paragraph Styles. Bydd hyn yn peri i’r teitl 

symud i ganol y dudalen, cynyddu o ran maint, a newid i ddefnyddio ffont pwysau 

trwm. 

Dyna greu eich arddull paragraff cyntaf.  

Yn yr un modd, mae angen creu arddulliau paragraff ar gyfer llinell enw’r awdur a’r 

manylion hawlfraint. 

Enw’r awdur 

Creu arddull a rhoi enw priodol iddi yn y blwch Style Name. 

Yn Basic Character Formats yn y ddewislen ar y chwith: 

 Newid Font Style: i Regular. 

 Newid Size: i 16pt. 

Yn Indents and Spacing yn y ddewislen ar y chwith:  

 Newid gosodiad Alignment i Centre. 

Manylion hawlfraint 

Creu arddull a rhoi enw priodol iddi yn y blwch Style Name. 

Yn Basic Character Formats yn y ddewislen ar y chwith: 

 Newid Font Style: i Italic. 

 Newid Size: i 10pt. 

Yn Indents and Spacing yn y ddewislen ar y chwith:  

 Newid gosodiad Alignment i Centre. 

Canlyniad 

Unwaith y byddwch wedi creu a gosod yr arddulliau hynny, dylai testun y dudalen 

edrych yn debyg i hyn: 

Teitl 

gan Enw’r Awdur 

Hawlfraint © 2011 Deiliad yr Hawlfraint 
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Gosod bylchau rhwng y llinellau 

Braidd yn agos i’w gilydd yw’r llinellau uchod. Wrth weithio gydag InDesign ar lyfr 

print, y demtasiwn fyddai ychwanegu llinellau ychwanegol rhyngddynt drwy bwyso 

Enter i greu toriad llinell. 

Fodd bynnag, er y byddai’r toriadau llinell ychwanegol hyn yn dangos mewn fersiwn 

print, nid ydynt yn trosglwyddo o gwbl i e-lyfr EPUB. 

Felly, rhaid creu gofod rhwng y llinellau mewn ffordd arall. 

Golygu arddull er mwyn gosod bylchau rhwng y llinellau 

Un ffordd o greu lle gwag o dan baragraff yw drwy ychwanegu gofod dilynol i’w 

arddull.  

I olygu arddull, dwbl-gliciwch enw’r arddull honno yn y ffenestr Paragraph Styles. 

Bydd hyn agor dewislen yr arddull. I ychwanegu gofod at ddiwedd y paragraff, 

cliciwch ar Indents and Spacing yn y ddewislen ar y chwith a chynyddu’r hyn a geir yn 

Space After: i ffigwr o’ch dewis chi. 

Bydd defnyddio’r arddulliau hyn i greu’r gofod rhwng y paragraffau yn sicrhau bod y 

gofod hwnnw’n cael ei drosi i’r e-lyfr EPUB. 

II.7 Ychwanegu toriad tudalen 

Wrth baratoi dogfen a fydd yn cael ei hargraffu yn InDesign, pan fydd angen cychwyn 

tudalen newydd heb i’r dudalen gyfredol fod wedi’i llenwi â thestun, yr arfer yw 

defnyddio toriadau llinell, e.e.: 

Type > Insert Break Character > Page Break 

Defnyddiwch y dull uchod i osod toriad llinell ar ôl y llinell hawlfraint. 

Yn anffodus, ni fydd toriad tudalen o’r math hwn yn trosglwyddo i e-lyfr EPUB, ond 

mae’n bwysig parhau i ddefnyddio’r toriadau llinell hyn er mwyn creu toriad tudalen 

sy’n ymddangos o fewn fersiwn print yn ogystal ag o fewn y ddogfen InDesign wrth i 

chi weithio. 

Er mwyn creu toriadau tudalen a fydd yn gweithio mewn e-lyfr EPUB rhaid defnyddio 

arddull paragraff. 

Wrth gynhyrchu EPUB o’r ddogfen InDesign ( File > Export > Save as type: EPUB ), fe 

fydd ffenestr EPUB Export Options yn ymddangos. O dan Contents, mae llinell a’r 

testun Break Document at Paragraph Style: arni. O roi tic yn y blwch gyferbyn â’r 

llinell honno, cewch ddewis un o blith arddulliau paragraff eich dogfen. Bydd yr 

arddull honno’n gweithredu fel toriad llinell, gan hollti’r cynnwys yn ddwy dudalen o 

flaen testun sydd â’r arddull honno wedi’i dewis ar ei gyfer.  
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Defnyddio arddull paragraff i nodi toriad llinell 

Mae dau ddewis posib wrth ddefnyddio arddull paragraff i nodi toriad llinell. 

1. Creu arddull paragraff ‘Toriad Tudalen’ penodol 

Y dewis cyntaf yw creu arddull paragraff yn benodol ar gyfer ei defnyddio fel 

y defnyddir toriad tudalen cyffredin. 

Gellir gwneud hyn drwy ddilyn y camau canlynol: 

1. Creu arddull paragraff newydd a’i alw’n Toriad Tudalen. 

2. Creu llinell newydd (drwy wasgu Enter) lle dymunir gosod toriad 
tudalen. 

3. Dewis y llinell newydd, a gosod yr arddull Toriad Tudalen arni. I bob 
pwrpas, bydd hyn yn trosi’r llinell honno yn doriad tudalen o fewn yr 
e-lyfr. 

4. Pan fydd y ddogfen orffenedig yn barod i’w chynhyrchu ar ffurf e-lyfr: 

a. File > Export > Save as type: EPUB 

b. Clicio ar Contents 

c. Rhoi tic yn y blwch ger Break Document at Paragraph Style 

d. Dewis Toriad Tudalen o’r gwymplen Paragraph Style 

2. Peri bod teitlau penodau yn gweithredu fel toriad tudalen 

Yn hytrach na chreu arddull paragraff yn benodol ar gyfer toriadau tudalen, y 

dewis arall yw defnyddio Break Document at Paragraph Style i osod toriadau 

tudalen ynghlwm wrth arddull paragraff teitl pob pennod. 

Er mwyn gwneud hyn rhaid inni ychwanegu teitl pennod i’r ddogfen. 

I wneud hynny, cliciwch o fewn y maes testun ar dudalen wag gyntaf y 

ddogfen a theipio ‘Pennod 1’, ac yna pwyswch Enter. 

Y cam nesaf yw creu arddulliau ar ei gyfer. I greu arddull ar gyfer teitlau 

penodau’r ddogfen, dilynwch y camau hyn: 

1. Clicio ar yr eicon Create a new style yn y ffenestr Paragraph Style 

2. Dwbl-gliciwch ar enw’r arddull i agor y ffenestr Paragraph Style 
Options 

3. Teipiwch  ‘Teitl Pennod’ dros y teitl presennol yn y blwch Style Name 

4. Cliciwch ar Basic Character Formats yn y ddewislen ar y chwith.  

5. Newidiwch Font Style: i Bold 

6. Newidiwch Size: i faint addas, e.e. 18pt 
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7. Cliciwch ar OK. 

8. Pan fydd y ddogfen orffenedig yn barod i’w chynhyrchu ar ffurf e-lyfr: 

  a. File > Export> Save as type: EPUB 

  b. Clicio ar Contents 

  c. Rhoi tic yn y blwch ger Break Document at Paragraph Style 

  ch. Dewis Teitl Pennod o’r gwymplen Paragraph Style 

II.8 Ychwanegu paragraffau testun 

Yna teipiwch neu gopïo a gludo testun o ffynhonnell arall hyd nes bod gennych tua 

hanner tudalen o destun mewn tri neu bedwar paragraff. Gellir cynhyrchu testun 

ffug ar wefannau fel http://www.lipsum.com a http://www.adhesiontext.com/ os 

oes angen. 

Paragraff a gofod yn ei ddilyn 

Gan nad yw’r fformat e-lyfr EPUB yn cadw llinell wag rhwng dau baragraff a 

gynhyrchir drwy bwyso Enter ddwywaith, rhaid creu arddull paragraff er mwyn 

gosod gofod ar ôl paragraffau sydd ei angen. 

I greu arddull paragraff a gofod ar ei ôl, dilynwch y camau hyn: 

1. Cliciwch ar yr eicon Create a new style yn y ffenestr Paragraph Style 

2. Dwbl-gliciwch ar enw’r arddull a grëwyd i agor y ffenestr Paragraph Style 
Options 

3. Teipiwch  ‘Paragraff Gofod Dilynol’ dros y teitl presennol yn y blwch Style 
Name 

4. Cliciwch ar Indents and Spacing yn y ddewislen ar y chwith 

5. Newidiwch Space After i faint addas, e.e. 5mm 

6. Cliciwch ar OK i gadw eich newidiadau 

Gallwn ddefnyddio’r arddull paragraff hon yn sail ar gyfer paragraffau â nodweddion 

ychwanegol, er enghraifft paragraffau â’r llinell gyntaf wedi ei mewnoli.  

Paragraff â’r llinell gyntaf wedi ei mewnoli 

Mewn llyfrau ffuglen, fel arfer, bydd llinell gyntaf pob paragraff, ac eithrio’r paragraff 

cyntaf mewn adran, yn cael ei mewnoli.  

Gallwn atgynhyrchu hyn drwy greu arddull paragraff newydd â’r llinell gyntaf wedi ei 

mewnoli. Byddwn yn seilio’r arddull paragraff hon ar yr arddull paragraff Paragraff 

Gofod Dilynol. Bydd hyn yn golygu y bydd yn cadw’r gofod dilynol ac y bydd gofod 

dilynol y ddwy arddull wastad yn gyson a’i gilydd. 

http://www.lipsum.com/
http://www.adhesiontext.com/
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I greu’r arddull, cliciwch ar yr eicon Create a new style yn y ffenestr Paragraph Style 

1. Dwbl-gliciwch ar enw’r arddull i agor y ffenestr Paragraph Style Options. 

2. Teipiwch  ‘Paragraff Mewnoliad’ dros y teitl presennol yn y blwch Style Name. 

3. Cliciwch ar Based On a dewis yr arddull Paragraff Gofod Dilynol.  

4. Cliciwch ar Indents and Spacing yn y ddewislen ar y chwith.  

5. Newidiwch First Line Indent i faint addas, e.e. 10mm. 

6. Cliciwch ar OK i gadw eich newidiadau. 

Gosod yr arddulliau paragraff ar y paragraffau priodol 

Gosodwch yr arddull Paragraff Gofod Dilynol ar y paragraff cyntaf gan nad ydym am i 

linell gyntaf y paragraff hwnnw gael ei mewnoli.  

Ar gyfer yr ail baragraff a’r paragraffau sy’n dilyn o fewn yr un adran, gosodwch yr 

arddull Mewnoli Paragraff arnynt. 

Cysylltnodi a rhannu geiriau 

Nid yw’r mwyafrif o e-ddarllenwyr a brofwyd yn cysylltnodi testun e-lyfrau (mae rhai 

e-ddarllenwyr, megis Kobo, yn eithriadau). Yr arfer yw gadael ymyl dde testun y 

dudalen yn anwastad tra bod yr ymyl chwith wedi’i unioni. Gellir arbrofi gyda 

defnyddio cysylltnodau meddal (http://en.wikipedia.org/wiki/Soft_hyphen) ar eiriau 

hir, ond nid yw’r modd yr ymdrinnir â hwy ar e-ddarllenwyr yn gyson. Cofiwch fod 

cysylltnodi priodol yn amrywio o iaith i iaith. Nid yw rheolau rhannu geiriau sydd 

wedi’u llunio ar gyfer y Saesneg yn addas ar gyfer y Gymraeg, oherwydd rhennir 

deugraffau fel ‘dd’, ‘ll’ a ‘rh’, er enghraifft. Mae hyn yn arfer anghydnaws â’r 

Gymraeg a dylid ei osgoi ar bob cyfrif. 

Allforio Tagiau (Export Tagging) 

I’r rhai sy’n gyfarwydd â golygu CSS, mae’r ddewislen Export Tagging yn y ffenestr 

Paragraph Style Options a Character Style Options yn caniatáu i chi osod arddulliau 

CSS penodol i gyfateb i’r arddulliau rydych wedi eu defnyddio yn eich dogfen. Gweler 

y tudalennau gwe hyn am ragor o wybodaeth:    

 Export Tagging to the Rescue! 
http://www.creativeprogression.com/taking-the-cs5-5-epub-plunge-export-
tagging-to-the-rescue/ 

 Preparing your InDesign files for ePub Export 
http://labs.oreilly.com/Bilodeau-IDtoEPub.pdf 

http://en.wikipedia.org/wiki/Soft_hyphen
http://www.creativeprogression.com/taking-the-cs5-5-epub-plunge-export-tagging-to-the-rescue/
http://www.creativeprogression.com/taking-the-cs5-5-epub-plunge-export-tagging-to-the-rescue/
http://labs.oreilly.com/Bilodeau-IDtoEPub.pdf
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II.9 Ychwanegu llythrennau ag acenion  

Gallwch ddefnyddio eich dull arferol i ychwanegu llythrennau acennog fel ŵ ac ŷ i’r 

ddogfen yn uniongyrchol yn y maes testun. 

Dyma grynodeb o’r dulliau ar gyfer eu hychwanegu gyda gwahanol systemau:  

Windows 

Os nad yw eisoes wedi’i ddewis, rhaid dewis yr UK Extended Keyboard: 

Windows 7 

Start > Control Panel > Change Keyboards or other input methods > Change 

keyboards > United Kingdom Extended  

Wedi gwneud hynny, gellir cynhyrchu llythyren ac acen arni drwy bwyso Alt Gr a 

bysell acen ar yr un pryd ac yna bwyso bysell y llythyren briodol. 

Gellir creu llythyren ag acen grom drwy bwyso Alt Gr a 6 gyda’i gilydd ac yna bwyso 

bysell y llythyren. Er enghraifft, i greu ŷ, dylid pwyso: 

Alt Gr a 6, yna y i greu ŷ 

Gellir creu priflythrennau ag acen hefyd: 

Alt Gr a 6, yna Shift ac y i greu Ŷ  

Dyma restr o’r cyfuniadau gan ddefnyddio’r llythyren y fel enghraifft: 

 Alt Gr ac y i greu ý  

 Alt Gr a 2, yna y i greu ÿ  

 Alt Gr a 6, yna y i greu ŷ 

 ` ac yna y i greu ỳ 

(` yw’r fysell o dan Escape ac i’r chwith o 1 ar y bysellfwrdd) 

Mac OS X 

Mae bysellfwrdd ar gyfer y Gymraeg ar gael ar gyfer fersiwn 10.3 ymlaen o Mac OS X. 

Gellir dod o hyd i hwn o dan Systems Preferences yn y ddewislen Apple. Am ragor o 

wybodaeth am greu llythrennau ag acenion ar gyfrifiaduron Apple, cyfeiriwch at 

Gymorth Mac OS ei hun.  

Meddalwedd To Bach 

Dewis arall yw To Bach gan gwmni Draig, meddalwedd ar gyfer Windows sy’n 

hwyluso gosod toeon bach ac acenion eraill ar lythrennau. Gallwch ei lawrlwytho o 

http://www.draig.co.uk/en-GB/download-27.aspx. Pan fydd wedi’i osod bydd modd i 

chi greu llythyren ag acenion drwy ddal Alt Gr i lawr a phwyso’r llythyren sydd angen 

yr acen. 

http://www.draig.co.uk/en-GB/download-27.aspx
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 Alt Gr ac y i greu ŷ  

 Alt Gr ac /, yna y i greu ý 

 Alt Gr a 2, yna y i greu ÿ  

InDesign 

Gellir hefyd ychwanegu llythrennau acennog fel ŵ ac ŷ i’r ddogfen yn InDesign drwy 

ddefnyddio’r ffenestr Glyphs. Os nad yw yn y golwg ar ochr dde y sgrin, gallwch ei 

hagor drwy glicio ar: 

Window > Type & Tables > Glyphs 

Yn y ddewislen Show gellir dewis y set briodol o glyffiau. 

Mae’r acenion ar gyfer a, e, i, o ac u i’w cael yn y set Basic Latin and Latin 1, a’r 

acenion crom (to bach) ar gyfer w ac y yn rhan o set Extended Latin A.  

Acenion sy’n digwydd yn y Gymraeg 

Mae’r acenion hyn yn bosib yn y Gymraeg: 

á é í ó ú  ẃ ý 

â ê î ô û ŵ ŷ 

ä ë ï ö ü ẅ ÿ 

à è ì ò ù 

Fel arfer y llythrennau ŵ, ŷ, Ŵ, ac Ŷ yw’r rhai problemus. Gall hyn fod oherwydd: 

 ni chafodd y llythrennau acennog eu defnyddio yn y lle cyntaf 

 cafodd y llythrennau acennog eu defnyddio, ond fe droswyd y ddogfen o 
amgodio fel UTF-8 (sy’n eu cynnwys) i set fel ISO 8859-1 nad yw’n eu 
cynnwys. Gall hyn ddigwydd yn anfwriadol wrth drosi ffeil o un fformat i’r 
llall. 

 nid yw’r ffont a ddefnyddir yn cynnwys glyff (delwedd o lythyren) ar gyfer y 
llythrennau hynny. Mae hynny’n syndod o gyffredin.   

Ychwanegwch yr acenion uchod i’r paragraffau sydd yn eich dogfen os nad ydych 
eisoes wedi gwneud hynny. Bydd hyn yn caniatáu i chi wirio a yw’r acenion wedi’u 
trosglwyddo’n gywir wrth greu’r fersiwn EPUB o’r ddogfen yn nes ymlaen.  

Crëwyd dogfen brofi er mwyn cynorthwyo gydag adnabod problemau â’r acenion. 

II.10 Ychwanegu arddulliau trwm, italig a thanlinellu etc. 
Rydym eisoes wedi disgrifio arddulliau paragraffau, sef yr arddulliau a ddefnyddir i 
osod arddullio testun ar lefel y paragraff. Er mwyn gosod arddull ar ddarnau unigol o 
destun o fewn paragraffau (yn hytrach na’r paragraff cyfan), dylid defnyddio 
arddulliau nodau (character styles). 
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Y defnydd mwyaf cyffredin a wneir o arddulliau nod yw er mwyn gosod arddull teip 

trwm neu italig, neu danlinellu gair neu eiriau o fewn y testun. 

Mae’r ddewislen Character Styles yn rhannu’r un ffenestr â’r ddewislen Paragraph 

Styles. Gellir newid rhyngddynt drwy glicio ar y tabiau ar dop y ffenestr. Os nad yw’r 

ffenestr yn y golwg, gellir ei dangos drwy glicio ar: 

Windows > Styles > Character Styles 

http://help.adobe.com/en_US/indesign/cs/using/WS60910FA3-2BD7-449d-9904-

05CFA551665Da.html 

Trwm 

I greu arddull nod ar gyfer testun trwm, dilynwch y camau hyn: 

1. Cliciwch ar yr eicon Create a new style yn y ffenestr Character Style 

2. Dwbl-gliciwch ar enw’r arddull a grëwyd i agor y ffenestr Character Style 
Options 

3. Teipiwch  ‘trwm’ dros y teitl presennol yn y blwch Style Name 

4. Cliciwch ar Basic Character Formats yn y ddewislen ar y chwith 

5. Newidiwch Font Style i Bold 

6. Cliciwch ar OK i gadw eich newidiadau 

Bydd modd i chi yn awr ddefnyddio’r arddull nod hon ar unrhyw lythyren, gair neu 

ddilyniant o eiriau sy’n llai na paragraff ac sydd i’w gosod mewn teip trwm. 

Italig 

I greu arddull nod ar gyfer testun italig, dilynwch y camau hyn: 

1. Cliciwch ar yr eicon Create a new style yn y ffenestr Character Style 

2. Dwbl-gliciwch ar enw’r arddull a grëwyd i agor y ffenestr Character Style 
Options 

3. Teipiwch  ‘italig’ dros y teitl presennol yn y blwch Style Name 

4. Cliciwch ar Basic Character Formats yn y ddewislen ar y chwith 

5. Newidiwch Font Style i Italic 

6. Cliciwch ar OK i gadw eich newidiadau 

Bydd modd i chi yn awr ddefnyddio’r arddull nod hon ar unrhyw lythyren, gair neu 

ddilyniant o eiriau sy’n llai na paragraff ac sydd i’w gosod mewn teip italig. 

Tanlinellu 

I greu arddull nod ar gyfer testun wedi’i danlinellu, dilynwch y camau hyn: 

http://help.adobe.com/en_US/indesign/cs/using/WS60910FA3-2BD7-449d-9904-05CFA551665Da.html
http://help.adobe.com/en_US/indesign/cs/using/WS60910FA3-2BD7-449d-9904-05CFA551665Da.html
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1. Cliciwch ar yr eicon Create a new style yn y ffenestr Character Style 

2. Dwbl-gliciwch ar enw’r arddull a grëwyd i agor y ffenestr Character Style 
Options 

3. Teipiwch  ‘tanlinell’ dros y teitl presennol yn y blwch Style Name 

4. Cliciwch ar Basic Character Formats yn y ddewislen ar y chwith 

5. Ticiwch y blwch underline 

6. Cliciwch ar OK i gadw eich newidiadau 

Bydd modd i chi yn awr ddefnyddio’r arddull nod hon ar unrhyw lythyren, gair neu 

ddilyniant o eiriau sy’n llai na paragraff ac sydd i’w danlinellu. 

Dewiswch ambell air neu eiriau o fewn paragraffau’r dudalen a gosod yr arddulliau 

rydych newydd eu creu arnynt.  

II.11 Tabl Cynnwys (TOC)  

Gall e-lyfr EPUB gynnwys ffeil sy’n rhestru penodau ac adrannau’r llyfr ar ffurf 

dolenni sy’n galluogi’r darllenydd i neidio’n uniongyrchol i leoliad y rhan honno o’r 

llyfr. Mae’r rhan fwyaf o ddyfeisiau a rhaglenni meddalwedd e-ddarllen yn gallu 

dangos yr wybodaeth hon mewn panel llywio sy’n annibynnol ar y ffenestr sy’n 

dangos testun y llyfr. Gall InDesign greu’r ffeil hon yn awtomatig yn seiliedig ar yr 

arddulliau paragraff a ddefnyddiwyd gennych ar gyfer y penawdau a geir yn eich 

dogfen. 

I gynhyrchu ffeil TOC ewch i: 

Layout > Table of Contents 

Yn y maes Title rhowch deitl (‘Cynnwys’, er enghraifft) ar gyfer y dudalen lle bydd y 

tabl cynnwys yn ymddangos, a dewiswch arddull paragraff ar ei gyfer yn y maes Style 

er mwyn pennu ei ymddangosiad. 

Y cam nesaf yw dewis yr arddulliau paragraff sy’n dynodi penodau neu brif adrannau 

eich llyfr. Yn y ddogfen hon, y brif arddull paragraff yw Teitl Pennod, felly dewiswch 

Teitl Pennod o’r rhestr Other Styles ac yna clicio ar Add er mwyn eu symud draw i’r 

rhestr Include Paragraph Styles. 

Gallwn hefyd ddewis is-adrannau y dylent ymddangos yn y tabl cynnwys. Dewiswch 

Heading 1 o’r rhestr Other Styles ac yna cliciwch ar Add er mwyn eu symud hwythau 

draw i’r rhestr Include Paragraph Styles. 

Os ydych yn dymuno, gallwch hefyd bennu arddull y gwahanol elfennau yn y rhestr, 

a defnyddio’r maes Level i reoli eu hierarchaeth. 
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Wedi i chi glicio ar OK, bydd eicon y pwyntydd yn newid. Rhaid gosod y tabl cynnwys 

a gynhyrchir drwy glicio ar dudalen briodol yn y eich dogfen. Cofiwch ychwanegu 

toriad tudalen ar ei ôl. 

II.12 Cynhyrchu’r e-lyfr EPUB 

Nawr fod cynnwys yn y ddogfen, mae’n bryd i ni droi ein sylw at baratoi’r ddogfen ar 

gyfer ei throsi’n e-lyfr. 

Ychwanegu Metadata 

Yn gyntaf, mae angen ychwanegu gwybodaeth am y llyfr i’r ddogfen fel metadata. 

Mae hyn yn cynnwys enw’r awdur, teitl y llyfr, rhif ISBN, ac yn y blaen. 

Yn InDesign, mae modd ychwanegu’r data hwn i’r ddogfen trwy glicio ar:  

File > File Info 

Bydd hyn yn agor ffenestr File Information ar gyfer y ddogfen.  

Mae’n syniad llenwi’r holl feysydd sydd o dan y tab Description os oes modd. Y 

meysydd sydd ar gael yw: 

 Document Title 

 Author 

 Author Title 

 Description 

 Rating 

 Description Writer 

 Keywords 

 Copyright Status 

 Copyright Notic 

 Copyright Info URL 

Bydd yr holl ddata yn cael ei ychwanegu i’r e-lyfr er mwyn helpu gyda’i ddosbarthu 

a’i gatalogio’n gywir, a bydd yn hwyluso’r defnyddwyr i’w ddarganfod wrth chwilio 

am chwileiriau perthnasol. Yr wybodaeth a geir yma a fydd yn cael ei defnyddio gan 

e-ddarllenwyr a gwefannau sy’n dosbarthu’r e-lyfr er mwyn dangos manylion megis 

enw’r awdur, ei deitl, ac yn y blaen, NID cynnwys testun y ddogfen ei hun.  

Noder y caiff enw’r cyhoeddwr ei ychwanegu mewn cam pellach. Caiff y dyddiad 

cyhoeddi ei ychwanegu’n awtomatig.  
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Gosod Meddalwedd E-ddarllen 

Yn ail, dylid sicrhau bod meddalwedd e-ddarllen wedi’i gosod ar y cyfrifiadur. Mae 

Adobe Digital Editions a Calibre yn raglenni y gellir eu lawrlwytho a’u gosod ar eich 

cyfrifiadur am ddim.  

Gydag Adobe Digital Editions gallwch ddarllen ffeiliau EPUB sydd â DRM Adobe 

arnynt ar eich cyfrifiadur. Mae’n bwysig gwirio ymddangosiad y llyfr yn y rhaglen hon 

gan ei bod yn debyg y bydd carfan helaeth o ddarllenwyr yn ei defnyddio. 

Mae Calibre yn rhaglen cod agored ddefnyddiol. Ni fydd yn gallu agor y ffeil EPUB 

unwaith y bydd Gardners wedi gosod y DRM arni, ond mae’n rhaglen anhepgor ar 

gyfer gwirio ac archwilio gosodiadau metadata’r ffeil EPUB cyn ei hanfon atynt.  

Awgrymwn eich bod yn gosod y rhaglenni uchod ar eich cyfrifiadur. Bydd hyn yn eich 

galluogi i agor yr e-lyfr gorffenedig wedi iddo gael ei gynhyrchu a bwrw golwg fanwl 

drosto. 

Dewisiadau Creu EPUB 

Mae nodwedd cynhyrchu ffeil EPUB InDesign ar gael drwy glicio ar File > Export ac 

yna ddewis EPUB o’r gwymplen Save as type. 

Bydd clicio ar Save yn agor ffenestr EPUB Export Options a fydd yn cynnwys llu o 

ddewisiadau sy’n pennu sut y bydd yr EPUB yn cael ei chynhyrchu.  

Dyma’r gosodiadau rydym yn eu hargymell fel man cychwyn: 

Tab ‘General’ 

 EPUB 

 EPUB Cover 
Mae’n syniad da darparu clawr ar gyfer eich e-lyfr, mae dau ddewis mewn 
gwirionedd, sef:  

1. Trosi tudalen gyntaf eich dogfen InDesign yn ddelwedd a’i defnyddio 
fel clawr. 

 Os delwedd o glawr eich llyfr yw tudalen gyntaf eich dogfen 
InDesign beth bynnag, mae hyn yn hwyluso defnyddio’r clawr 
hwnnw fel clawr yr e-lyfr.  

 Os testun sydd ar eich clawr, bydd y testun hwn yn cael ei 
droi’n ddelwedd o’r testun a’i ddefnyddio fel clawr. 

I ddewis y dull hwn, cliciwch ar: Rasterise First Page. 

2. Nodi lleoliad delwedd o glawr a grëwyd y tu allan i InDesign a’i 
ymgorffori o fewn yr e-lyfr er mwyn ei defnyddio fel clawr. 
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Y maint a argymhellir fel arfer gan gwmnïau dosbarthu e-lyfrau yw 600px 

(lled) wrth 800px (uchder). Awgrymir hefyd y dylid cadw maint y ffeil rhwng 

tua 80 a 200KB. 

Wedi dweud hynny, mae maint a chydraniad dyfeisiau yn esblygu’n barhaol.   

 Ordering 

 Formatting Options 

 View EPUB after Exporting 

I ddewis y dull hwn, cliciwch ar Use Existing Image File a darparu llwybr i'r ffeil y 

dymunwch ei defnyddio.  

Tab ‘Image’ 

Gadael y rhain fel y maent 

Tab ‘Contents’ 

 Format for EPUB Content 

 Contents 

o Rhoi tic wrth Break Document at Paragraph Style 

o Dewis yr arddull paragraff addas: 

 Toriad Tudalen os ydych wedi defnyddio’r arddull paragraff 
Toriad Tudalen i nodi lle dylid rhannu tudalennau gan fod 
angen rheoli hynny’n fanwl gennych 

 Teitl Pennod os llyfr syml sydd gennych a dim ond o flaen teitl 
penodau y mae angen toriad tudalen. 

 CSS Options 

o Generate CSS a rhoi tic wrth Include Embeddable Fonts 

(Mae mewnblannu ffont addas yn sicrhau y bydd e-ddarllenwyr fel 
Adobe Digital Editions yn dangos ŵ ac ŷ yn gywir) 

Pan fyddwch yn hapus â’r dewisiadau, ticiwch yn y blwch View EPUB After Exporting 

a chlicio ar y botwm OK er mwyn cynhyrchu’r ffeil EPUB. 

Os ydych wedi gosod Adobe Digital Editions ar eich cyfrifiadur fel y rhaglen a 

ddefnyddir i agor ffeiliau .epub, bydd eich e-lyfr yn agor yn Adobe Digital Editions. 

Gallwch yn awr fwrw golwg ar gynnwys y llyfr er mwyn ceisio adnabod unrhyw 

broblemau gyda’r gosodiad. Gall hyn gynnwys achosion lle na ddefnyddiwyd yr 

arddull paragraff neu arddull nod cywir, neu ddiffyg toriad tudalen yn y man cywir. 
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Os ydych yn dod ar draws problem, ewch yn ôl i’r ffeil yn InDesign i’w chywiro, cau 

Adobe Digital Editions, a chynhyrchu’r EPUB eto. Ailadroddwch y camau hynny hyd 

nes eich bod yn hapus â’ch e-lyfr. 

II.13 Dilysu 

Gellir dilysu e-lyfr i sicrhau ei fod yn cydymffurfio â safonau EPUB drwy ddefnyddio 

rhaglenni pwrpasol sy’n cymharu cod yr e-lyfr â’r hyn â ragnodir gan y safon honno. 

Mae gwefannau ar gael sy’n cynnig gwasanaeth dilysu e-lyfrau, e.e. 

http://threepress.org/document/epub-validate, ond nid yw’r rhain mewn 

gwirionedd yn addas ar gyfer defnydd masnachol gan eich bod, wrth eu defnyddio, 

yn cyflwyno copi heb ei ddiogelu o gynnwys yr e-lyfr i drydydd parti. 

Yn hytrach, mae’n well defnyddio rhaglenni dilysu y mae modd eu gosod yn lleol ar 

eich cyfrifiadur, e.e. FlightCrew: http://code.google.com/p/flightcrew/, gan na fydd y 

ffeil yn gadael eich cyfrifiadur o’u defnyddio. 

Mae nodwedd ddilysu hefyd ar gael yn Sigil, rhaglen am ddim ar gyfer creu a golygu 

e-lyfrau. Defnyddia’r un cod yn union â FlightCrew.  

II.14 Gwirio pellach 

Dilysiad technegol yn unig yw’r dilysu a wneir gan raglenni dilysu EPUB. Nid yw’r 

ffaith fod e-lyfr EPUB yn pasio’r broses ddilysu yn golygu y bydd yr e-lyfr yn 

ymddangos yn union fel y bwriadwyd gennych ym mhob dyfais neu raglen e-ddarllen 

gan fod y modd y mae’r gwahanol e-ddarllenwyr yn dehongli safon EPUB yn 

amrywio. Y gwirionedd yw fod gan y mwyafrif o e-ddarllenwyr ambell chwinc, ac o 

ganlyniad argymhellir gwirio ymddangosiad yr e-lyfr a gynhyrchwyd ar gynifer o 

ddyfeisiau ac mewn cynifer o raglenni e-ddarllen ag y mae modd, gan flaenoriaethu’r 

dyfeisiau mwyaf poblogaidd.  

E-ddarllenwyr sy’n gweithio gydag Adobe eBook DRM 

Gellir cael rhestr o’r dyfeisiau sydd â thrwydded i ddangos e-lyfrau EPUB gyda DRM 

Adobe yma:  

http://blogs.adobe.com/digitalpublishing/supported-devices 

Dyma restr o’r rhai hynny sydd ar gael ar gyfer dyfeisiau amlbwrpas symudol:  

Android 

 Aldiko 

 Biblet 

 BlueFire 

 DL Reader 

http://threepress.org/document/epub-validate
http://code.google.com/p/flightcrew/
http://blogs.adobe.com/digitalpublishing/supported-devices
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 Emviem 

 ePagine Reader 

 Gato Sabido 

 Google Books 

 Kalahari.net eReader 

 Sony Reader App 

 TookBook 

iOS 

 Book Shelf 

 Bertelsmenn 

 BlueFire 

 DL Reader 

 aNobii Reader 

 Kobo 

 Libranda 

 Emviem 

 Numilog Reader 

 Biblet 

 txtr 

Gall y problemau a geir wrth brofi e-lyfr ar yr e-ddarllenwyr hyn amrywio o 

broblemau gydag edrychiad yr e-lyfr (arddulliau heb eu defnyddio’n gywir, acenion 

coll, ac elfennau fel tablau a delweddau wedi’u torri) i broblemau mwy difrifol sy’n 

rhwystro’r e-lyfr rhag agor yn llwyddiannus.   

Awgrymir canolbwyntio ar sicrhau bod yr e-lyfr yn gweithio ar Adobe Digital Editions. 

Mae trafodaethau ar y gweill i weld a oes modd datblygu fersiwn o Bluefire Reader 

sy’n addas ar gyfer y Gymraeg, ond ar hyn o bryd y feddalwedd sy’n cael ei ffafrio 

gan Gardners yw Digital Editions. 

Chwinciau Hysbys E-ddarllenwyr 

Nid yw’r ffont a ddefnyddir gan Adobe Digital Editions yn cynnwys ŵ ac ŷ. Er mwyn i 

Adobe Digital Editions ddangos ŵ ac ŷ yn hytrach na ?, rhaid mewnblannu ffont.  
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Nid yw pob e-ddarllenydd yn cefnogi mewnblannu ffontiau. Os ydych chi’n creu e-

lyfr â ffont wedi’i fewnblannu er mwyn i’r ŵ a’r ŷ ddangos yn gywir, bydd rhai e-

ddarllenwyr yn anwybyddu’r ffont hwnnw, neu mewn achosion prin yn gwrthod agor 

yr e-lyfr o gwbl. 


